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In this Recipe, you will learn how to create an animated movie using Frames. You will
import a folder of images, add a title, credits, text effects, music, shapes, and
transitions, and then export the animation as a movie. 
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Introduction

Open Frames. 

Click the Start button. 

Choose All Programs, choose the Tech4Learning folder, choose the Frames folder,
and select Frames. 

Frames will open.
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Add a Folder of Images

When Frames opens, you will see an empty animation. You need to add frames to the
animation to begin. 

In this tutorial, you will add sample images from the Library. 

If you have taken your own clay animation pictures with a digital camera, you can add
them using the Add Images from a Folder button in the Preview area. 

Click the Library tab.

You will see the folders in the Library.
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Double-click the Tutorial folder to open it. 

Click the Clay Animation folder to select it. 
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Click and drag this folder into the Preview area. 

You will see the cursor change to show that you are adding the frames in this folder. 

Let go of the mouse button. 

You will see each frame in the Frame List. 

You will also see the last frame in the Preview area. 
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If you see the Storyboard, click the Frame List tab. 

Preview the Animation
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You can preview the animation. 

The timeline is currently set to the last frame. 

Click the First Frame button in the Preview area. 

Click the Play button in the Preview area to watch the animation. 

The animation will end at the last frame of the animation.

Copy and Paste Frames

You can copy and paste frames in the animation to have frames and actions repeat. 

The last frame of the animation is selected in the Frame List. 
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Press and hold down the Shift key on the keyboard. 

Click the first frame of the animation. 

All of the frames will be selected. 
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Click the Copy button on the toolbar. 

Click the last frame of the animation. 

Click the Paste button on the toolbar. 
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All of the frames will be pasted at the end of the animation.

Save the Animation

You should save the animation as you work on it. 

Click the Save button on the toolbar. 

You will see the Save Animation As dialog. 
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Type a name for the animation in the File name field. 

Use the Save in pull-down menu to choose the place you want to save the file. 
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Click the Save button. 

The animation will be saved.

Add a New Frame

You can add more frames to an animation such as a frame for a title. 

Click the New Blank Frame button at the bottom of the Frame List. 
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You will see a new frame. 

You will also see a blank frame in the Preview area.

Change the Order of Frames

You can change the order of frames in an animation. 

The last frame in the Frame List is selected. 

Click and drag this frame to the top of the Frame List. 

Release the mouse button when you see a black line above the first frame in the Frame
List. 

Page 14 of 41Create an Animated Idiom
Frames - Clay Animation

Recipes4Success www.recipes4success.com ©  2006 Tech4Learning, Inc.



The blank frame is now the first frame in the animation. 

Change the Background Color

You can change the background color of a frame. 

Click the first frame in the Frame List. 

Click the Options tab to see the editing options for the frame. 

Click the Fill color box in the Options panel. 

You will see a color palette. 
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Click a new color on the palette. 

The preview will show this new color on the frame.

Add a Text Object

You can add text to create a title for the animation. 

Click the Text button on the toolbar. 

You will see a text object in the middle of the frame. 
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Double-click the text object. 

You will see a blinking cursor. 

Type: What’s the Idiom? 

Click the frame outside of the text object when you are done. 

The text object will no longer be selected. 

Format Text

You can change the way text looks. 

Click the text object to select it again.
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Move the cursor over a corner handle. 

It will change to two arrows. 

Click and drag the corner handles away from the center of the text object until it takes
up most of the frame. 
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Click the Font pull-down menu on the Options panel to choose a new font. 

Click and drag the Size slider on the Options panel to make the font larger. 

The preview will change as you drag the slider. 

Click the Fill color box to choose a new text color. 

You will see a color palette. 

Click the color you want for the text. 
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Click the gray area around the preview when you are done. 

Change Frame Duration

You can change the length of time a frame is shown. The title frame should last longer
than other frames in the animation. 

You will see the frame duration in the Options panel. 
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Add and Edit Another Frame

You can add another frame at the end of the animation. 

Click the last frame in the Frame List. 

Click the New Blank Frame button at the bottom of the Frame List. 

You will see a new frame added to the end of the Frame List. 
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The frame will show in the preview area. 

Use the skills you have learned to change the background color. 

Click the Text button on the toolbar. 

You will see a text object in the middle of the frame. 

Use the skills you have learned to add and format text that says: 

Get Your Ducks in a Row! 
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Add a Text Effect

You can add effects to your text. 

Click the Text Effect button on the toolbar. 

You will see the text effect options in the Options panel. 

Click Fade in the Effect list. 

Leave the Duration set to 1 second. 
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Click the Apply button. 

You will see this Warning message telling you that the text cannot be edited after the
text effect is run. 
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Click the OK button. 

Frames will render the frames needed for the text effect. 

You will see the frame turn into a group in the Frame List. 

Click the plus symbol next to the group to see all of the frames. 

Click the last frame in the group. 

Change the duration on this last frame to 2 seconds. 
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Click the Save button on the toolbar to save the changes you have made. 

Click the First Frame button in the Preview area. 

Click the Play button to see a preview of the movie. 

Add a Transition

You can add transitions between frames in an animation. This is a great way to move
from a stationary title to the first frame in an animation. 

Transitions are added after the selected frame. 

Click the first frame in the Frame List to add a transition between frames one and two. 
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Click the Transition button on the toolbar. 

You will see the transition options in the Options panel. 

Select Blend from the Transition list. 

Leave the Duration set to 1 second. 
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Click the Apply button. 

You will see the transition frames being processed. 

You will see the transition in the Frame List. 

Page 28 of 41Create an Animated Idiom
Frames - Clay Animation

Recipes4Success www.recipes4success.com ©  2006 Tech4Learning, Inc.



Add Sound

You can add sound to an animation. 

Click the First Frame button in the Preview area to have the sound start at the
beginning of the animation. 

Click the Library tab. 

Click the Home button. 

Double-click the Sounds folder. 
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Double-click the Music folder. 

Find and click the Cartoon sound. 

You will see buttons on the sound. 

Click the Add button. 

The sound will be added to the animation starting at the first frame. 
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Add a Shape

You can add a shape, such as a thought bubble, to a frame. 

Click the second duck01 frame. 

You will see this frame in the preview area. 

Click the Shape button on the toolbar. 

Click the square thought bubble. 
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Move the cursor over the frame in the Preview area. It will change to a crosshair. 

Move the cursor to the top of the frame, near the middle. 

Click and drag down and to the right to draw the shape. 

Release the mouse button. 
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You will see the shape on the frame. 

Add a Caption

You can add text and place it over the thought bubble. 

Click the Text button on the toolbar. 

You will see a text object in the middle of the frame. 

Click the Options tab. 
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Click the text Fill color button on the Options panel and choose Black.

Click and drag the text object over the thought bubble. 

Click and drag the sizing handles if you need to change the size of the text box. 

Double-click the text object. 

You will see a blinking cursor. 

Type: Quack! 

Press the Enter key on the keyboard. 
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Type: Quack! 

Press the Enter key on the keyboard. 

Type: Quack! 

Go to the Edit menu and choose Select All to select all of the text. 

Use the Font pull-down menu and Size slider on the Options panel to change how the
text looks. 

Click the gray color in the preview area when you are done. 
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Since this frame has text, you will want it to show for a longer time so that the viewer
can read the text. 

Click and drag the Duration slider on the Options panel to the right to show the frame
for 3 seconds. 

Click the Save button on the toolbar to save the changes you have made. 
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Click the First Frame button in the Preview area. 

Click the Play button to see a preview of the animation. 

Make a Movie

You can export the animation as a movie file you can share with other people. 

Click the Make button on the toolbar.

You will see the Export Animation dialog. 

Click the Presentation radio button. 
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Click the Export button. 

You will see the Save As dialog. 
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Use the Save in pull-down menu to choose a place to save the file. 

The name of the Frames file is already in the File name field. 
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Click the Save button. 

Frames will create the movie. 

When it is finished, you will see a Finished Exporting dialog. 
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Click the Launch button to watch your movie.

Conclusion

Go to the File menu and choose Exit.

Congratulations! You have created an animated movie using Frames. 

In this Recipe, you learned how to:

Open Frames 

Add a folder of images 

Copy and paste frames 

Preview an animation 

Save an animation 

Add a blank frame 

Change the order of frames in a movie 

Add text 

Format text 

Add text effects 

Add transitions 

Add sound 

Add a shape 

Make a movie
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